ACTION REQUIRED — Update WebScan

WebScan is a utility program required for Remote Deposit scanner service. IMPORTANT: Failure to act will
result in a Remote Deposit (RD) service disruption.

Administrative access to the computer will be required. Contact your company Information Technology (IT)
Administrator for assistance making the required changes. If you fail to act, a service disruption will be
experienced.

You will need to uninstall WebScan, then install the most up-to-date version.

Your steps will be determined by your scanner model.

Panini Scanners Non-Panini Scanner Types
Action required migration weekend Action required as soon as possible

Step 1: Uninstall WebScan version 17. Step 1: Uninstall your current version of WebScan.

Step 2: Remove 2 folders in the company Step 2: Remove 2 folders in the company Windows C drive library.

Windows C drive library. Step 3: Open Remote Deposit and go to the Help menu on the top right. Click

Step 3: Open Remote Deposit and go to the “Download WebScan” link for WebScan to install.

Help menu on the top right. Click “Download Step 4: Update WebScan’s Domain Settings.

WebScan” link for WebScan to install.
Step 5: Enter the following URL: “https://remotedeposit.associatedbank.com”
into the Remote Domain URL bar & Update WebScan
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Uninstalling Your Current WebScan Version

ATTN: Panini clients must action the below on the Monday following their migration weekend.

*Note: In order to make these updates, you will need your IT administrator to apply changes to programs on your PC.

[} Programs and Features

« ™ & Control Panel > All Control Panel ltems Programs and Features

Control Panel Home .
Uninstall or change a program

i 1 r . H i
View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.
G Turn Windows features on or

ff
@ Organize ~ Uninstall Change Repair

Install a program from the

network Name Publisher Installed On  Size Version
 Trellix Agent Trellix 12/6/2022 57.7.378
@ webScan FIS 12/9/2022 195MB 221203 |
8 Windows Firewall Configuration Provider Microsoft Corporation 12/6/2022 342 KB 1234120
Zscaler Zscaler Inc. 1/4/2023 708 MB 3.9.0.183

[yl Programs and Features

«— v T l'j » Control Panel * All Control Panel tems > Programs and Features v [&] Search Programs and Features

Control Panel Home .
Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

E;‘ Turn Windows features on or

off Organize * Uninstall Change  Repair
Install a program from the ~ i : i
network Name Publisher Installed On  Size Version
o QU n FIS 12/9/2022 19.5MB  22.1.203
is Firewall Configuration Provider Microsoft Corporation 12/6/2022 342KB 1.234120
Change Zscaler Inc. 1/4/2023 708 MB 3.9.0.183

' FIS Product version: 22‘1.203.
Size: 19.5MB

Repair

Access your PC’s Control Panel> Programs & Features> Locate “WebScan’ in your list of programs.

Delete 2 Folders
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Once WebScan has been uninstalled there are 2 folders within your PCs ‘C: Drive’ to locate.

7 s | Windows (C:)

: &8 Extra large icons &= Large icons
B Preview pane
&5 Mediumicons 22 Smallicons

I

Navigation g Details pane

pane ¥ =5 List "':: Details

Panes Layout

B Desktop Intel
Nautilus Printer Spool

PerfLogs

= Documents

¥ Downloads

Ko Program Files

= Program Files (x86)
&= Pictures ProgramData «
| Videos TeFilesOutput

£ 9 Windows (C) Users

|| Group by ¥ Q] Item check boxe:

_] Add columns ~ D File name extension:
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Sort . Hide selected
by~ [ Size all columns to fit <z Hidden item;> | items

Current view
5/22/2023 11:35 PM
12/9/2022 3:54 PM
12/7/2019 3:14 AM
5/22/2023 11:37 PM
4/4/2023 11:00 PM
6/7/2023 10:24 AM
12/9/2022 3:04 PM
5/22/2023 10:53 AM

Show/hide
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder

First, access your ‘C: Drive’, click the ‘View’ tab at the top, ensure the ‘Hidden Items’ checkbox is checked, then locate &

access the ‘ProgramData’ folder.
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a— View v

Extra large icons
Large icons

Medium icons

Documents

Small icons I & E OneDrive - Pd
b

List
140

Details ywnloads

Tiles

Content

Compact view

Show Navigation pane

Details pane

Preview pane

ltem check boxes
File name extensions

Hidden items

(Windows 11 view of ‘Hidden Items’ checkbox.)
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| ¥ + | ProgramData
Home Share View
« v 1 « Windows (C:) » ProgramData
D Name
A Quick access
Adobe

 This PC Advanced Financial Solutions
B 3D Objects Cisco

I Desktop Citrix
“= Documents Express Software Manager

Open in new window

Pin to Quick access

i Scan with Microsoft Defender...

v

(J]

Date modified

1/4/2023 1:26 PM
12/9/2022 3:32 PM
12/6/2022 9:59 AM
12/9/2022 3:06 PM
6/6/2023 10:40 AM
12/9/2022 3:45 PM
12/6/2022 9:53 AM
5/10/2023 11:06 AM
12/9/2022 4:35 PM
12/6/2022 9:12 AM
4/11/2023 11:01 AM
12/9/2022 3:03 PM
11/19/2020 1:45 AM
12/9/2022 3:54 PM
4/11/2023 11:02 AM
3/24/2023 9:10 AM
1/24/2023 1:21 PM
6/7/2023 11:55 AM
4/4/2023 11:00 PM

AT INA0 .14 AKA

» Search ProgramData

Type

File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder

Ciln £mlddne

Size

- Give access to >
< Restore previous versions
B (Cisco Secure Endpoint >
=
& Combine supported files in Acrobat...
L
Include in library >
Pin to Start
ft
Send to > |
Cut
27 it .
C
| Capt opy
. Porte Create shortcut
Sify dat E Delete 3
Rename

Within the ‘ProgramData’ folder, locate & delete the FIS folder.
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+ | Windows (C)

Home Share View

::-;| W

& = ~ / &3> This PC » Windows (C) v D
~ D Name
# Quick access
ABC
B This PC Intel

¥ 3D Objects Nautilus Printer Spool

B Desktop Perflogs
“= Documents Program Files
¥ Downloads & Program Files (x86) >
D Music ProgramData
— 5 TeFilesOutput
& Pictures
B Users
Vid

o8 Windows

£ 7 Windows (C) .

Second, return to the ‘C: Drive’, access the ‘Program Files (x86)" folder.
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£ Search Windows (C:)

Date modified

12/6/2022 10:32 AM
5/22/2023 11:35 PM
12/9/2022 3:54 PM
12/7/2019 3:14 AM
5/22/2023 11:37 PM
4/4/2023 11:00 PM
6/7/2023 1:10 PM
12/9/2022 3:04 PM
5/22/2023 10:53 AM
5/23/2023 12:01 PM
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Type

File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder



| v = | Program Files (x86)

Home Share View

i v 1T « Window... » Program Files (x86) » v
[ ] Name
# Quick access
Cherwell Asset Management
W This PC Cisco
¥ 3D Objects Citrix
I Desktop Common Files
s Documents Fast Ltd
I Denlands FIS
Open
| Open in new window
»
Pin to Quick access
j fd  Scan with Microsoft Defender...
Give access to >
£
Restore previous versions
£
= (isco S Endpoint
] isco Secure Endpoin > ent Extensi._
Combine supported files in Acrobat...
L 4
Include in library >
Pin to Start
Send to >
Cut
Copy
Create shortcut
® Delete

(9]

Date modified

4/4/2023 11:00 PM
12/6/2022 9:55 AM
12/6/2022 12:24 PM
4/4/2023 11:00 PM
4/4/2023 11:00 PM
12/9/2022 3:45 PM
12/9/2022 4:35 PM
6/7/2023 12:55 PM
12/6/2022 9:53 AM
5/22/2023 11:34 PM
12/9/2022 3:54 PM
1/26/2023 11:04 AM

12/13/2022 11:40 AM

5/15/2023 9:17 AM
5/22/2023 11:35 PM
12/6/2022 12:22 PM
12/6/2022 9:28 AM
2/14/2022 3:07 PM
12/6/2022 9:27 AM
2/14/2022 3:01 PM
2/14/2022 3:01 PM
12/6/2022 9:27 AM
12/6/2022 9:28 AM
1/8/2022 2:45 AM

Within the ‘Program Files (x86)’ folder, locate and delete the FIS folder.
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£ Search Program Files (x86)

Type

File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
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Download the most current version of WebScan

*Associated Bank recomends using Google Chrome for WebScan installations.

Remote Deposit

Remote Deposit User Guides

Remote Deposit User Guide

Remote Deposit Getting Started Guide

Remote Deposit Workflow Reference Guide

Remote Deposit FAQ

Scanner User Guides

=

Remote Deposit Scanner Drivers

Download Panini |IDeal Driver

Download MyVisionX/Panini Driver (32 Bit)

Download MyVisionX/Panini Driver (64 Bit)

Download Digital Check TellerScan Driver

Download Epson S1000 Driver (32 Bit)

Download Epson S1000 Driver (64 Bit)

Download Other Drivers

WebScan v17 (for PANINI SCANNERS W/WINDOWS 10 ONLY)

WebScan (for ALL OTHER SCANNERS)
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L Sign-in to Associated Connect®, access the Remote Deposit Portal and click on the ‘Help’ menu. Select ‘WebScan’ to

initiate the download.

ﬁ Associated Bank
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ﬁ Approvals Administration Research Reports Help ~

» Download WebScan

1posit
Welcome AB Client Download Scanner Drivers »
Today is 03/01/2023 at 3:09:58 PM. AB Client, your last sign-in was on 03,  RDC User Guide .
1:04:10 PM.
About
For any additional information, please call Treasury Management Custome.
800-270-2707, option 2. Select an Account .
Thank you.
Control Total
$ | 0.00
Create Tape Create Deposit
Deposits

Your ‘Help’ menu may look like this as well, if so, select Download WebScan.
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4 Approvals Administration Research Reports Help -

Create Deposit

@ save As X
<« v 4 . » ThisPC » Desktop v D L Search Desktop
QOrganize ~ New folder = - @
~
v W This PC " Name Date modified Type Size
3 3D Objects No items match your search.
> m Desktop
4 Documents

4 Downloads
J Music

= Pictures

B Videos

%9 Windows (C) «

File name: | WebScan_AssociatedBank v

Save as type: | Application b

A Hide Folders " Cancel

This will populate a ‘Save As’ screen. Choose a permanent location from the left side that you will be able to easily
access in future steps for the WebScan file. Click ‘Save’ at the lower right. You may see a similar download screen.

ﬁ Associated Bank
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¥ v + BTt Downloads
Home Share View Compressed Folder Tools
« v I~ & » This PC » Documents > Downloads v U Search Dow
W This PC ~ [ Name Date modified Type Size

s 3D Objects ;f] WebScan_AssociatedBank-New (1) 10,360 KB

m Desktop _:{,1 WebScan_AssociatedBank-New (2) 10,360 KB

Document: ;«3 WebScan_AssociatedBank-New 10,360 KB

W it o *~7ociatedBankV22 d (zipp 10,343 KB

Open

Open in new window

Pin to Start

e Cisco Secure Endpoint

& Edit with Notepad++

L Scan with Microsoft Defender...
1> Share

Open with...

Restore previous versions

Once Saved, from your permanent location, right click on the zip folder and select ‘Extract All’.
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><I

Extract Extract Compressed (Zipped) Folders

Home Share View Compressed Folder Tools
& = + 4 ¥ > ThisPC > Documents > Downloads Select a Destination and Extract Files

= This PC ~  [] Name " Files will be extracted to this folder:
- is

¥ 3D Objects @ WebScan_AssociatedBank-New (1) I[\\R\J‘1NCRE—FS[}[}1SP\USERSS;\EBYERSC|2\Dc:cuments\\.r“.iebscan_,ﬂ\s,s,rcncia‘[edB; Browse...
B Deskiop @ WebScan_AssociatedBank-New (2)

= " @ WebScan_AssociatedBank-New Show extracted files when complete

=| Document:

= o i WebScan AssociatedBankV22
Nevamlnars

151 items 1 item selected 10.0 MB

R

Make note of the extraction location and click ‘Extract’ at the lower right.

v 5 S WebScan_AssociatedBankV22 — O
I Home Share View Compressed Folder Tools
&« v 4~ 1 » ThisPC » Documents > Downloads » WebScan AssociatedBankV22 v (]
W This PC ~ [ Name Type Compressed size Password pr...  Size Ratio
3 3D Objects B WebScan_AssociatedBank Application 10343 KB No 10,360 KB 1%
m Desk
1 Docu Cut
4+ Dow Copy
& Musi Delete
= Pictul
. Properties
B Vided. —

1item 1 item selected 10.1 MB

Once extracted, right click on the file and select ‘Open’.
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[@l WebScan — X

Welcome to the WebScan Setup Wizard P

The installer will guide you through the steps required to install WebScan on your
computer.

WARNING: This computer program is protected by copyright law and international
freaties. Unautharized duplication or distribution of this program, or any portion of it, may
result in severe civil or criminal penalties, and will be prosecuted to the maximum extent
possible under the law.

< Back Cancel

This will initiate the WebScan Setup Wizard. Click ‘Next’.

[ |_[%l WebScan — bt

i Select Installation Folder ]_‘

| The installer will install WebSean o the following folder.

To install in this folder, click "Nexdt”. To install to a different folder, enter it below or click
| "Browse".

Folder:
C\Program Files (x8B)\FIStWebScan\ Browse...

Disk Cost...

, <Back (__ Next> D  Cancel

The installer will auto-select a folder location for the WebScan program. Select ‘Next’ to proceed.
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{15 WebScan — X

Confirm Installation l_'h

The installer is ready to install WebScan on your computer.

Click "Next" to start the installation.

<Back <m Cancel

Select ‘Next’ to Confirm Installation.

ﬂ WebScan - X

Installing WebScan LA

WebScan is being installed.

Please wait...

< Back Next > Cancel

A status bar will populate to reflect installation status.

ﬁ Associated Bank
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[_@ WebScan - X

Installation Complete LA

WebScan has been successfully installed.

Click "Close" to exit.

Please use Windows Update to check for any critical updates to the NET Framework.

< Back ( Close Cancel
— -

WebScan has been successfully installed. Click ‘Close’ on the lower right.

ﬁ Associated Bank
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Accessing WebScan’s Domain Settings

@

of (ws
@ T

2:54 PM
Snow coming =

3/1/2023

In the lower right corner of your PC, click the ‘up carrot’ to display your PCs programs.

Open Log Viewer

2:55 PM

SnqwEaning & @ O 3/1/2023 E51

Right Click on the ‘WS’ icon and select ‘Settings’
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@ WebScan Configuration

Setting Type:

==Choose Setting== v

A ‘WebScan Configuration’ screen will pop out and will allow you to select a ‘Setting Type’ from the dropdown list. Click
the dropdown.

@ WebScan Configuration

Setting Type:
==Choose Setting==
==Choose Setting==
Panini Settings
Canon Settings
SmartSource Settings

From the dropdown list, select ‘Origin Domain Settings’.
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Adding Domain URL & Updating WebScan

@ WebScan Configuration — L]

Setting Type:
Origin Domain Settings v

Origin Domain Settings

Remate Domain URL:

» https: //remotedeposit. associatedbank. com

_Add Domain_> Remove Selected

https: //dImlr1 3.fisglobal.com

Cancel |Ipdate
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In the ‘Remote Domain URL’ box enter the following URL: “https://remotedeposit.associatedbank.com” into the Remote
Domain URL bar exactly as shown above. Once confirmed, click ‘Add Domain’.
*IMPORTANT*: Please ensure the URL is entered exactly as shown above if you are updating your WebScan prior to

migration weekend.

ﬁ Associated Bank
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@ webscan Configuration — [] X

Setting Type:
Origin Domain Settings v

Origin Domain Settings

Remate Domain URL:

Add Domain Remove Selected

. https: //remotedeposit. associatedbank. com
https: //dImlr1 3.fisglobal. com
https: //associatedconnect fisglobal. com

Cancel

Selecting ‘Add Domain’ will move the URL from the upper ‘Remote Domain URL’ field down into the list of added

domains. Once this is confirmed, select ‘Update’ at the lower portion of the screen.

ﬁ Associated Bank
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Restart WebScan?

WebScan must be restarted for these changes to take effect. Would
you like to restart WebScan now?

— N
( Yes | No

This will prompt WebScan to restart. Select ‘Yes’ on the lower right to restart WebScan. Your settings have been

updated and you are now ready to scan checks on the updated platform.
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